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USING THIS TEMPLATE  
his document is intended to serve as a 
simple template to format fifth edition 
supplements in Microsoft Word. Before 
using this template, you should complete 
the following steps, or it may not work 
correctly. The PDF included in your 
DMsGuild download is a direct export of 

this Word document, so you can see exactly how it should 
look when you open the Word template. 

INSTALL LATEST VERSION OF WORD 
This template is designed for use with Word 365 or 2019 on 
Windows 10. If using a previous version of Office or are on 
a Mac, the template will likely still work, but your mileage 
may vary. When you first open the template on an old 
version, a few page elements may be in a different place 
than in the sample PDF. However, as long as you do all 
your layout on just one computer, and export the PDF from 
it as well, it’s likely to work without issue. 

Regardless of what version of Office you have, it’s 
recommended that you install the latest Windows and 
Office updates for it. Open Windows Update, choose 
Advanced Options, and check the “Give me updates for 
other Microsoft products when I update Windows” box. 

INSTALL FONTS 
All but one of the template fonts are licensed for 
commercial use under the Open Font License. They must 
be installed before opening this template in Word. The 
fonts are all included in your DMsGuild template 
download, or you can get them straight from Google Fonts: 

• Merriweather (serif body text) 
• Trirong (serif header text) 
• Source Sans Pro (san-serif text) 
• EB Garamond (cover title text) 
• Alegreya Sans (cover subtitle text) 

The drop caps font is free for commercial use, but you 
will need to download it separately using the following 
link, then install it: 

• Royal Initialen (decorative drop cap font) 

TURN ON BACKGROUND PRINTING 
After finishing the above steps, open this DMsGuild Word 
template. Next, you need to enable printing of background 
elements (instead of leaving them out to save toner). If you 
skip this step, your exported PDF won’t include the 
parchment background, and will be white instead. 

• On the File menu, click Options. 
• On the Display menu, find Printing Options. 
• Check “Print background colors and images,” click OK. 

OPEN STYLES GALLERY 
The text formatting in this document relies on Styles. Open 
the Styles gallery by going to the Home tab, then clicking 
on the pop-out arrow to open the Styles window: 

After you do so, a floating Styles 
box will appear that looks like this. 
Drag it to the right side of screen to 
dock it as a sidebar. Very important: 
Before doing anything else, click on 
the Options button in the Styles pane 
and select the following options: 

APPLYING STYLES 
When using this template, do not format things manually, 
except for when you need to do something that doesn’t 
have a style (which will happen very rarely). Instead, when 
you need to change the format of any text, select the style 
you need from the Styles pane. The later pages of this 
template contain many examples and instructions for how 
to select and apply the correct styles to your document. 
Only use styles that start with “5E,” the rest are Word 
default styles that you can ignore. 

The thing you’re most likely to need to manually adjust 
is paragraph spacing, as you might find times you need 
more space before/after a particular style than the style 
automatically provides. To do this, go to Paragraph 
Settings; you may need to change the points before or after 
a particular paragraph, or to uncheck the box “Don’t add 
space between paragraphs of the same type.” 

USE PARAGRAPH STYLES TO BOLD/ITALICIZE 
Rather than using the buttons on the ribbon (or Ctrl-B and 
Ctrl-I) to bold and italicize text, you can assign character 
styles to do the same. This may seem arduous at first, but 
has three primary benefits: 

• Keeps Word from creating new temporary character 
styles for every style that you modify by bolding text. If 
you bold a word without using the “*5E – CHAR BOLD” 
style, Word will start showing a second “5E – CORE 
BULLETS” style with the bold attribute added… and so 
on for every single style you add bold or italics to. 

• Makes it safer to apply paragraph styles to large blocks 
of text without worrying about a particular word losing 
its bolding or italicization. It’ll always keep that 
character style on it once assigned. 

• If you ever send your Word document to a layout 
designer for professional layout in InDesign, it’s easy for 
for them to migrate your text over to the final InDesign 
layout and easily see how words should be formatted. 

T 

https://medium.com/@356labs/how-to-easily-install-multiple-fonts-d8bb3eb615d5
https://medium.com/@356labs/how-to-easily-install-multiple-fonts-d8bb3eb615d5
https://fonts.google.com/specimen/Merriweather
https://fonts.google.com/specimen/Trirong
https://fonts.google.com/specimen/Source+Sans+Pro
https://fonts.google.com/specimen/EB+Garamond
https://fonts.google.com/specimen/Alegreya+Sans
https://www.1001fonts.com/royal-initialen-font.html


4 

QUICK STYLE GUIDE 
The above chapter title uses the “5E – HEADING CHAPTER” 

style. To put an epigraph/quote at the beginning of a section 

like this, you can apply the “5E – EPIGRAPH PARA1” style. 

Note: If you’re not adding a second paragraph to your 

epigraph, you’ll need to manually change the space after 

PARA1 to 9 points—the default for PARA1 is to have no space, 

allowing a second paragraph to follow immediately after. 

If you add a second paragraph, format it with “5E – 

EPIGRAPH PARA2” to properly indent the new paragraph.  

—Epigraph Author, Epigraph Source 

This paragraph uses the “5E – CORE BODY PARA1” style. 
The paragraph following it uses “5E – CORE BODY 
PARA2,” which is indented. Though this may seem 
complicated, it keeps the first paragraph formatted 
correctly, and distinct from later paragraphs. 

After you’ve properly introduced your chapter, you can 
launch into headings below. Note that to follow fifth 
edition style, you should never use two headings in a row 
without putting at least a bit of text between them. 

HEADING 1 
The above heading uses “5E – HEADING 1.” The current 
paragraph uses more of “5E – CORE BODY PARA1,” and if 
you added another paragraph here, it would use PARA2. 

HEADING 2 
After a heading comes more text. While you should 
(almost) always proceed through headings in order, H1, 
H2, H3, there is one exception: if you’re presenting a spell 
or item statistics within an H1 section, it’s okay to skip this 
H2 and go directly to H3. Otherwise, be sure to use it. 

HEADING 3 
Core metadata (for example, listing spell level and school, or 
item attunement and rarity) 

Core Hanging: This is a hanging indent; these are 
generally used for lists of items. To make the section 
before the colon bold, highlight it then assign the “*5E 
CHAR BOLD” style. For an example of this in practice, 
check out the PHB’s section on Dwarf Names. 

Good for Spell Info: You can also use this style for things 
like spell casting times. This style is also sometimes 
known as “Core Stat.” 

When Should You Use Hanging Indents? If your section 
functions like bullet points except each “bullet” starts 
with a bolded title, you should generally use hanging 
indents rather than using inline subheads. On the other 
hand, if you’re using the titles to split up sections that 
would work better as a subheading of H3, that’s an 
inline subhead—you can read more on those later in this 
section. Note that lists with hanging indents should 
almost always be preceded by a colon, just like bullets 
would be. 

Here we’re going to switch back to body text for a moment, 
just for fun, then it’s onto the inline subheads. How do 
those work? Good question. 

This Is an Inline Subhead. We don’t need a separate 
paragraph style for this—all that matters is that the first 
line is indented, so we first use “5E – CORE BODY PARA2”, 
then the first sentence/title is bolded and italicized, so we 
highlight that title and assign “*5E CHAR BOLD & ITALIC 
(INLINE SUBHEAD).” Yes, the style name’s a mouthful, it 
gets the job done. 

Inline Subheads Can Be Considered H4. In general, if the 
content within it could work as another subheading (if 
headings beneath H3 existed), it should go into an inline 
subhead, which is sometimes informally known as H4. On 
the other hand, if you have a section that functions like 
bullet points except each “bullet” starts with a bolded 
title, you should use hanging indents, not inline 
subheads—you can read more on those earlier in this 
section. 

What Happens If You Need H5? If you’re already in an H4 
section (aka an inline subhead), and need to nest yet 
another heading beneath it… Well, generally, you 
shouldn’t. Ideally, you’ll revise the section to make 
everything at a higher heading level. However, sometimes 
that doesn’t work. In that case, you can actually use the 
hanging indents previously discussed to form what some 
people call a “hanging subhead.” 

This Is a Hanging Subhead. It uses the same “5E – CORE 
HANGING” style as other hanging indents, but what 
makes it a hanging subhead is that you italicize the 
“heading” before the period. You also don’t necessarily 
have to precede hanging subheads with a colon, unlike 
most other instances of hanging indents. 

An Example of Hanging Subheads. You can see an example 
of a hanging subhead (H5) beneath an inline subhead 
(H4) in the PHB under Rock Gnomes. There, gnomes are 
given a choice of three devices they can create—those 
are formatted using an H5. 

How Do Bullets Work? Generally, if you have a bulleted 
list but you want to give each bullet a title, it uses the core 
hanging style instead. On the other hand, when you want a 
simple list of bullets, just use “5E – CORE BULLETS.” Note 
that bulleted lists should almost always be preceded by a 
colon, like this: 

• This is a bullet. 
• Guess what? This is another one. 
• And one more for good measure.  

https://www.dmsguild.com/product/267467/DMs-Guild-Creator-Resource--Style-Guide-Resources?affiliate_id=1650578
https://www.dmsguild.com/product/267467/DMs-Guild-Creator-Resource--Style-Guide-Resources?affiliate_id=1650578
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SAMPLES TO COPY 
his section provides specialized text that you 
might commonly encounter, designed for easy 
copy-and-paste. You can create a drop cap, 
like the one at the beginning of this paragraph, 
by highlighting the paragraph you want to 

apply it to. Next, click on Insert > Drop Cap > Drop Cap 
Options, change the font to Royal Initialen, and change 
“Lines to Drop” to 5. Finally, highlight the drop cap letter, 
and change the text color to “Red, Accent 1.”  If the 
paragraph you’re applying it to is italicized, you’ll also 
have to toggle off the italics for the drop cap. 

SAMPLE SPELL 
This is a sample spell, formatted using this template so 
you can see the text styles in action. Note: spells generally 
use H3 even if they don’t have an H2 before them. 

EXPEDITIOUS RETREAT 
1st-level transmutation 

Casting Time: 1 bonus action 
Range: Self 
Components: V, S 
Duration: Concentration, up to 10 minutes 

This spell allows you to move at an incredible pace. When 
you cast this spell, and then as a bonus action on each of 
your turns until the spell ends, you can take the Dash 
action. 

SAMPLE MAGIC ITEM 
This is a sample magic item, formatted using this template 
so you can see the text styles in action. Note that magic 
items generally use H3 (even if they don’t have an H2 
before them, as in this section). 

BOOTS OF THE WINTERLANDS 
Wondrous item, attunement (requires attunement) 

These furred boots are snug and feel quite warm. While 
you wear them, you gain the following benefits: 

• You have resistance to cold damage. 
• You ignore difficult terrain created by ice or snow. 
• You can tolerate temperatures as low as −50 degrees 

Fahrenheit without any additional protection. If you 
wear heavy clothes, you can tolerate temperatures as 
low as −100 degrees Fahrenheit. 

SAMPLE TABLES 
Tables use the “5E – TABLE CELL” paragraph style; for 
headers, use the same style, but add the “*5E – CHAR 
BOLD” character style to it. 

There are two ways you can display tables, depending on 
your needs. They can either be placed in-line with your 
body text (as if they’re just another block of text), or they 
can be placed in a text box (which allows them to float 
freely so you can move them to different sections of the 
page). This section contains samples of each for easy 
copy-and-pasting. If you click on a table then go to the 
Table Design tab, under Table Styles there is a “5E TABLE” 
style that produces the alternating colored rows seen in 
this section. 

TABLE INLINE WITH TEXT—THIS MOVES WITH TEXT 

TWO SIDE-BY-SIDE TABLES—INLINE WITH TEXT 

 
 

  

T 
Level Max. CR Limitations Example 

2nd 1/4 No flying or swimming speed Wolf 

4th 1/2 No flying speed Crocodile 

8th 1 - Giant Eagle 

d100 Result  d100 Result 

01-08 This is a result  59-64 This is a result 

09-13 This is a result  65-74 This is a result 

14-19 This is a result  75-78 This is a result 

20-22 This is a result  79-80 This is a result 

23-27 This is a result  81-83 This is a result 

28-42 This is a result  84-85 This is a result 

43-44 This is a result  86-92 This is a result 

45-53 This is a result  93-94 This is a result 

54-56 This is a result  95-96 This is a result 

57-58 This is a result  97-00 This is a result 

TWO SIDE-BY-SIDE TABLES—IN TEXT BOX 

d100 Result  d100 Result 

01-08 This is a result  59-64 This is a result 

09-13 This is a result  65-74 This is a result 

14-19 This is a result  75-78 This is a result 

20-22 This is a result  79-80 This is a result 

23-27 This is a result  81-83 This is a result 

28-42 This is a result  84-85 This is a result 

43-44 This is a result  86-92 This is a result 

45-53 This is a result  93-94 This is a result 

54-56 This is a result  95-96 This is a result 

57-58 This is a result  97-00 This is a result 

 

TABLE IN TEXT BOX—YOU CAN DRAG THIS AROUND 

Level Max. CR Limitations Example 

2nd 1/4 No flying or swimming speed Wolf 

4th 1/2 No flying speed Crocodile 

8th 1 - Giant Eagle 
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SAMPLE MONSTER 
This is a sample monster, formatted using this template so 
you can see the text styles in action. As long as you apply 
all the styles to your monster exactly as in the sample stat 
blocks, Word will automatically insert the red dividers 
between sections; if you have red dividers showing up 
where they don’t belong, double-check that all the Stat 
Block Data lines use the “5E – STAT BLOCK DATA” style, 
that the ability score names (STR/DEX/etc) use “5E – 
STAT BLOCK ABILITY SCORE NAME,” and that the ability 
score numbers use “5E – STAT BLOCK ABILITY SCORE 
NUMBER.” 

Single Column. The single-column monster stat block 
uses a single text box and is very easy to work with—just 
resize it as desired. 

Two-Column. The two-column stat block is a little more 
complicated behind the scenes, but you can use it much 
like the single column. The stat block is comprised of three 
text boxes. The first one is a full-width text box that 
should have no text in it, and serves only as the 
background. The other two text boxes have no background 
or outline, but are set up right next to each other; when the 
first one overflows, Word automatically puts the extra text 
in the second column. Then, all three columns are grouped 
together so that when you move one, they all move.  

If your two-column stat block is longer/shorter than the 
sample included, click once on the whole stat block to 
select the group, then on the outline that appears, there 
will be two different dots at the top and bottom—the outer 
one refers to the group, the inner one 
refers to the individual box. Click the 
outer of the two dots to resize it to be 
taller/shorter. If you try to resize and 
only the background moves, not the 
text too, you selected the wrong dot. 

 

 
  

 
Stat block metadata 

Armor Class 10 

Hit Points 9 (2d8) 

Speed 30 ft. 

STR DEX CON INT WIS CHA 

10 (+0) 10 (+0) 10 (+0) 10 (+0) 14 (+2) 11 (+0) 

Saving Throws enter here 

Skills enter here 

Damage Resistances enter here 

Damage Immunities enter here 

Condition Immunities enter here 

Senses darkvision 60 ft., passive Perception 12 

Languages enter here 

Challenge 1/4 (50 XP) 

Inline Subhead. The inline header has the bold/italic character style, 

and this paragraph uses the “5E – STAT BLOCK BODY PARA1” style. 

Rarely, you may need to have a second paragraph for a particular 

monster feature; when you do, use the PARA2 style, which removes the 

space before it and adds a first-line indent. 

Spellcasting. The creature is a 1st-level spellcaster. Its spellcasting 

ability is Wisdom (spell save DC 12, +4 to hit with spell attacks). The 

acolyte has following cleric spells prepared: 

Cantrips (at will): light, sacred flame, thaumaturgy 

1st level (3 slots): bless, cure wounds, sanctuary 

Multiattack. This continues using the same stat block body style as in 

the previous section. 

Really Big Stick. Melee Weapon Attack: +9 to hit, reach 10 ft., one 

target. Hit: 12 (2d6 + 5) bludgeoning damage. 

Another Really Big Stick. Melee Weapon Attack: +9 to hit, reach 10 ft. 

one target. Hit: 15 (3d6 + 5) bludgeoning damage. 

Legendary action instructions use “5E – STAT BLOCK BODY PARA1” just 

as the text in previous section did. 

Legendary Action. Be sure to use the “5E – STAT BLOCK HANGING” style 

for your legendary actions, not the body style. And use the bold 

character style for each one’s title. 

Legendary Action. This is another legendary action. 

Legendary Action. This is another legendary action. 

Stat block metadata 

Armor Class 10 

Hit Points 9 (2d8) 

Speed 30 ft. 

STR DEX CON INT WIS CHA 

10 (+0) 10 (+0) 10 (+0) 10 (+0) 14 (+2) 11 (+0) 

Saving Throws enter here 

Skills enter here 

Damage Resistances enter here 

Damage Immunities enter here 

Condition Immunities enter here 

Senses darkvision 60 ft., passive Perception 12 

Languages enter here 

Challenge 1/4 (50 XP) 

Inline Subhead. The inline header has the bold/italic character 

style, and this paragraph uses the “5E – STAT BLOCK BODY PARA1” 

style. 

Rarely, you may need to have a second paragraph for a 

particular monster feature; when you do, use the PARA2 style to 

remove the space before it and add a first-line indent. 

Multiattack. This continues using the same stat block body style 

as in the previous section. 

Really Big Stick. Melee Weapon Attack: +9 to hit, reach 10 ft., one 

target. Hit: 12 (2d6 + 5) bludgeoning damage. 
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SAMPLE RACE 
This is a sample race, formatted using this template so you can 

see the text styles in action. A race usually starts with an 

epigraph to give flavor to the race. We’ll name our race the 

Clippies in honor of everyone’s favorite Office companion. Use 

the “5E – EPIGRAPH PARA1” style for this paragraph. 

—Epigraph Author, Epigraph Source  

After the epigraph comes a brief description of the race’s 
background and lore, sometimes followed by more 
sections of fluff. What would the Clippy race be like? It’s up 
to you! 

FIERCE WARRIORS OF THE OFFICE 
You  can write as much fluff as you want about your new 
race of Clippies! Once you’re done writing everything you 
need to help players tell the story of a character of that 
race, it’s time for names. 

CLIPPY NAMES 
Give the players a few examples of male names, female 
names, and surnames (or whatever other names are 
appropriate) for their new Clippy character. 

Male Names: Name 1, Name 2, and so on. This line uses a 
hanging indent. 

Female Names: Name 1, Name 2, and so on. This line uses a 
hanging indent. 

Surnames: Name 1, Name 2, and so on. This line uses a 
hanging indent. 

CLIPPY TRAITS 
And now it’s time to give the actual racial traits for your 
Clippy race. This generally includes ASI information, age 
range, alignment tendencies, size, speed, languages, and 
any unique traits that members of this race have in 
common. Sometimes you might add a subrace too. Notice 

that we jump directly to inline subheads (aka H4), even 
though there’s not an H3 in between. This is one of the few 
times you should skip headers; usually you want to 
immediately follow an H2 with an H3—but not for racial 
traits! 

Ability Score Increase. State here what ability scores 
your race gets an increase on. 

Age. What’s their general lifespan? When are they 
considered adults?  

Alignment. Do they tend to be good, evil, or fall 
anywhere on the spectrum because free will is a good 
thing? (Hint: free will is a good thing. Please don’t make 
races that are innately evil!) 

Size. What’s their height in IRL measurements, and are 
they Tiny, Small, Medium, Large, Huge, or Gargantuan? 

Speed. What’s their base walking speed? Can they fly, 
swim, or climb? 

Languages. What languages do they speak? 
Unique Racial Traits. Every race has other neat things 

they do. What neat things can the Clippies do? Your 
imagination’s the limit!  

Subrace. If you want to have more than one subrace of 
Clippies, more power to you. 

ADAMANTINE CLIPPY 
Subraces generally are under an H3. Give a little more 
information what your subrace is like. What makes 
adamantine clippies different from their mithral kin? 

Ability Score Increase. A subrace generally gives a unique 
ASI that the other subrace doesn’t. 

More Unique Racial Traits. What are neat things that 
adamantine clippies can do? 

MITHRAL CLIPPY 
This is another subrace. What makes mithral clippies so 
very special? What can they do? 

Ability Score Increase. Once again, assign a unique ASI 
for the subrace that’s different than the one you gave the 
adamantine subrace. 

More Unique Racial Traits. You know the drill by now. 
Go write racial traits!  
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SAMPLE CLASS 
This has samples of class/subclass features, formatted 
using this template so you can see the text styles in action, 
along with the class tables for easy copy and paste. 

CLASS FEATURES 
Use the following templates to format your class features. 

HIT POINTS 
Hit Dice: Use the “5E – CORE HANGING” style, bolding the 

text before colon using “*5E CHAR BOLD.” 
Hit Points at 1st Level: Same as above. 
Hit Points at Higher Levels: Same as above. 

PROFICIENCIES 
Armor: Likewise, all of these proficiencies should use “5E 

– CORE HANGING” style, bolding the text before colon 
using “*5E CHAR BOLD.” 

Weapons: Insert weapons here 
Tools: Insert tool proficiencies here 
Saving Throws: Insert saving throws here 
Skills: Choose two from [list here] 

EQUIPMENT 
Equipment lists should use “5E – CORE BULLETS”: 

•  (a) a wooden shield or (b) any simple weapon 
• (a) a scimitar or (b) any simple melee weapon 
• Leather armor, an explorer's pack, and a druidic focus 
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SPELLCASTING 
This section is included to show how to format the 
spellcasting ability lines, as well as bonus spells. 

SPELLCASTING ABILITY 
You can format the below spell save DC and spell attack 
modifier lines using “5E – CORE SPELLCASTING 
ABILITY.” 

 
Spell save DC = 8 + your proficiency bonus + your Wisdom 

modifier 

Spell attack modifier = your proficiency bonus + your 

Wisdom modifier 

BONUS SPELLS 
If a subclass grants bonus spells, use the standard table 
format, which is copied below for ease of use. It’s 
recommended that you use an inline table, not one floating 
in a text box, since these should always fall immediately 
after the bonus spells section. 

 

SAMPLE SPELLS TABLE 

SAMPLE SIDEBAR 
You can copy and paste the following sidebars or read-
aloud text boxes. Within each box are examples of the 
formatting used. Note that both boxes use the same 
sidebar text styles; read-aloud boxes are formatted the 
same way. 

These are easily resized to be full-width or single-
column, so this template doesn’t provide a separate 
example of full-width sidebars. 

SAMPLE LIST 
Rarely, you may need to make a list that has two half-
columns within the standard column. You can see this in 
chapter 11 of the PHB, where it lists all the spells by class 
list. The simplest way to create such a list in Word is to use 
a table with two columns, a single row, and no borders or 
shading. When you enter text, enter all of it within the 
same row instead of splitting across rows, as follows.  

 

 

You can also create single-column lists using the same “5E 
– LIST ITEM” style within the main body of the document. 

 

LIST TITLE 

List item 

List item 

List item 

 

Class Level Spells 

3rd spell name, another spell name 

5th spell name, another spell name 

7th spell name, another spell name 

9th spell name, another spell name  

LIST TITLE 

Lists should use “5E – List 

Item” for a hanging indent  

List item 

LIST TITLE 

List item 

List item 

LIST TITLE 

List item 

List item 

LIST TITLE 

List item 

List item 

List item 
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PUBLISHING YOUR 
FINISHED DOCUMENT 
After you’ve formatted everything the way you want it to 
appear in the final PDF, here are the final steps you’ll need 
to take to publish on DMsGuild! 

CHANGE COVER IMAGE 
If you haven’t already done so, take a moment to change 
the sample typewriter cover to your own cover art. To do 
so, click on that image on the first page. Once highlighted, 
click on the Picture Format toolbar, then click Change 
Picture. Browse to your 8.5” x 11” cover image and insert it. 
Repeat the same steps for the back cover. 

PREPARING PDF BOOKMARKS 
If you’ve correctly used the styles in this document for all 
your headers, your PDF will automatically include 
bookmarks for everything you labeled with “5E – 
HEADING CHAPTER,” “5E – HEADING 1,” and “5E – 
HEADING 2.” Before exporting the PDF, you can check that 
you did this correctly by going to the View toolbar, then 
check the box for Navigation Pane. This shows you exactly 
what will export to the PDF (however, note that the 
Navigation Pane shows Header 3, while the PDF will not). 
If something is showing up in your Navigation Pane that 
isn’t actually a header and thus shouldn’t be a bookmark, 
click on it, then change the text style to something other 
than the 3 styles mentioned above. 

If you have a header that is one of the above styles, but 
you don’t want it to appear in the PDF bookmarks, you can 
edit that after generating the PDF by installing the free 
version of PDF-XChange Editor. Open your PDF in PDF-
XChange Editor, then enable the bookmarks sidebar by 
pressing Ctrl-B (or by going to View > Show/Hide > 
Navigation Panes > Bookmarks). From there, you can edit, 
delete, or create bookmarks; just be sure to save your 
changes to the PDF when finished. 

COMPRESS IMAGES 
Depending on the resolution of the images you used, it 
might make the final 
PDF extremely large. To 
reduce your file size, 
click on one of your 
highest-resolution 
images in the Word 
document, then click on 
the Picture Format 
toolbar that appears. In 
the Adjust section, click 
Compress Pictures to 
open this dialog: 

 

Be sure to uncheck the box for “Apply only to this 
picture,” because you want Word to compress all your 
images at once. Then select the maximum resolution you 
want your images to have; 220 ppi is ideal for most 
supplements, but if your final file size is prohibitively 
large, you may want to reduce it to 150 ppi; this will reduce 
image quality a little, but is still acceptable for PDF 
supplements (Note: if you select a low-resolution picture, 
it’ll gray out all the higher resolution options, even if you 
have other images in the document that are that 
resolution. Be sure to select one of your highest-resolution 
images when you do this step, or it might restrict your 
option to 96 ppi). Once you click OK, it’ll compress all your 
pictures so none of them are larger than the resolution you 
selected. 

SAVING TO PDF 
After you’ve finished the above steps and are ready to 
publish your document, save a final copy in the normal 
DOCX format (if you need to make updates later, you can’t 
use Word to edit a PDF, you’ll need the original Word file). 
Next, go to File, Save As, and click Browse. On the next box 
that opens up, click the dropdown box and select PDF: 

 
 
 
 
 
 
 
 
 
Beneath that, be sure 

you select “Optimize for 
Standard (Publishing 
online and printing).” 
Then click the Options 
button, which will open 
the dialog you see to the 
right of this paragraph. 

The most important 
options to select are 
“Include non-printing 
information” (check all 
boxes), “Optimize for 
image quality,” and 
“Bitmap text when fonts 
may not be embedded.” 
Do not check “PDF/A” 
compliant! 

Once you’ve set those 
options, you can save 
your PDF. It may take a 
minute or more to 
generate—don’t worry if your computer freezes for a 
moment, it’ll eventually finish.  

https://www.tracker-software.com/product/pdf-xchange-editor
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USING IMAGES 
Adding art to your supplement is one of the easiest ways to 
add polish. Here are some quick tips on how to make the 
most of Word’s picture tools. 

However, keep in mind that putting a lot of images in 
your Word document will increase your PDF’s file size. You 
may even experience some slowness while editing the text 
within Word. Be sure to note the “Compress Images” 
section on the previous page for instructions on how to 
reduce your image file size before publishing. 

INSERTING ART 
You can drag and drop art from the Windows File Explorer 
straight into Word, or click the Insert tab, then click 
pictures. Once it’s inserted and you click on the image, 
you’ll see a Picture Format toolbar appear. 

POSITIONING YOUR IMAGE 
For almost all art, you’ll want to change the Wrap Text 
options to either Tight (wraps text around the shape of 
that image), Top and Bottom (makes text skip the lines it 
occupies), but otherwise lets you move it freely), Behind 
Text (allows you to freely position anywhere, and makes 
text appear in front of the image), or In Front of Text 
(allows you to freely position anywhere, and hides text 
behind it). 

 
By default, Word tries to restrict your image to keep it 

within the page margins. To place an image outside them 
(as with a full-page-width image at the top or bottom of 
page, as common in official sourcebooks), you can either 
set it to appear Behind Text (which doesn’t wrap text), or 
you set it for Top and Bottom wrap, then uncheck the box 
for Move with Text (which allows you to put it in the 
margins of your page, but still easily wrap text around it). 

IMAGE EFFECTS 
While Word isn’t intended for photo manipulation, there 
are some basic effects it can add to your images. A few of 
the most useful are demonstrated here, with examples on 
the right of page. 

PICTURE STYLES 
You can select a wide range of Picture Styles from a 
dropdown menu, including frames, drop shadows, and 
faded edges. In addition, you can customize the styles by 
opening the Format Picture dialog box (see red arrow for 
where to click). 

ARTISTIC EFFECTS 
You can also do some quick “photomanipulation” to add 
art filters to your pictures, though the options are far more 
limited than a photo editor like Photoshop (paid) or GIMP 
(free) would allow.  

PICTURE STYLES: SIMPLE FRAME  

PICTURE STYLES: DROP SHADOW: BLUR: 10, DISTANCE: 3 

PICTURE STYLES: SOFT EDGE RECTANGLE  

 

COLOR: SET TRANSPARENT COLOR  

 
 

ARTISTIC EFFECTS: PAINT BRUSH  
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MISCELLANEOUS FAQ 
This section includes miscellaneous tips and tricks to help 
you get the most out of this template. 

IMPORTING TEXT WITH OTHER FORMATS 
If you copy and paste text into this template from another 
document, it will likely import with different styles than 
the ones you need to use. Good news, all of the right 
template styles start with “5E” to make them easy to find. 

You can make changes en masse to other styles that 
come in with imported text: 

• Click on a paragraph holding the text you need to 
reformat—the Styles window will jump to that style. 

• Hover over that style and click the down arrow next to it. 
• Click “Select all # Instances.” When you do so, Word will 

think for a moment, then highlight all the times in the 
document that use that exact formatting. 

• With all the text that needs to change highlighted, click 
on the new style you want to switch it to—for example, 
the “5E – CORE BODY PARA2” style. Word will switch all 
that text to using the Core Body style with indented first 
lines. After that, it’s easy to go through and change the 
first paragraph of each section to correctly use the “5E – 
CORE BODY PARA1” style without the indent, while 
leaving the rest formatted with the proper indent. 

HOW TO UN-ITALICIZE EPIGRAPH TEXT 
If you have a style that applies italics (or bold) to a block of 
text, but you need a portion of it to be formatted without it, 
you can (counterintuitively) un-italicize it by highlighting 
that text, then selecting the “*5E CHAR ITALIC” style. 
This will reverse the italicization on that paragraph. For 
example, this is useful if you need to un-italicize a word in 
an italicized epigraph. 

CHANGING FONT SIZE 
The core body font size in this template is roughly 
equivalent to that of a Wizards of the Coast hardcover 
(even though this font is Merriweather 8 pt., this 
particular font is larger than Bookmania 9 pt., the font 
used in hardcovers). If you wish to increase the font size, 
you can do so by right-clicking on the “5E – CORE BODY 
PARA1” style and selecting Modify. On the Style Options 
screen that opens, change the font size dropdown box to 
9-point font, then click OK. This will automatically change 
the Paragraph 2 style as well. You can change other styles 
(such as sidebar fonts) the same way. 

 

USING ON A MAC 
This template has been successfully used on Word for Mac, 
though files created using a Windows computer might 
appear slightly differently on a Mac, and vice versa. You 
can use either a Mac or Windows computer for your layout, 
but it’s not recommended to work on the same file with 
both systems and expect it to open with the same layout on 
both—there may be minor shifts in image and text 
placement. 

For best results, install all Office updates before using 
this on a Mac; to do so, open Word, then on the top menu, 
click Help > Check for Updates. 

Here are the known issues that beta testers have 
intermittently seen while using Word for Mac: 

• Hyperlinks and clickable Table of Contents don’t reliably 
export (this is an overall Word for Mac issue, and not 
something that this template causes). If your document 
needs hyperlinks and they don’t export, consider 
exporting final PDF using a Windows computer; 
however, be sure the layout hasn’t changed when you 
switch operating systems! 

• In some versions of Word for Mac, sidebars have had 
intermittently distorted text upon PDF export. If this 
happens, you can try changing sidebar font to Arial. 

• If you’re using this on a Mac and experience other 
issues, please email me and let me know so I can add it 
to the list (or try to fix it). 

PARAGRAPH VS. CHARACTER STYLES 
This template uses both paragraph and character styles. 
Paragraph styles affect the entire paragraph, and can’t be 
used to format just part of it. In contrast, character styles 
allow you to apply selective formatting (e.g. bold) to just a 
few characters if you wish, while leaving the underlying 
paragraph style untouched. 

You can easily identify which are which in the Styles 
sidebar: the character styles are prefixed with an asterisk 
and appear at the top of your style list. You can also 
identify them by the icon Word displays to the right of that 
style name. Character styles have an “a” icon, paragraph 
styles have a “¶” icon. 

SLOW PERFORMANCE 
Depending on your computer, it may be slow to work with 
a Word document that has a lot of pictures embedded (as 
does this sample template). To work around this, don’t add 
any pictures until you’ve finished writing & layout.  

mailto:lhirsb@gmail.com?subject=5E%20Word%20Template%20on%20a%20Mac
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